Saving Chestnut’s Historic Character:
A Risk Assessment for an East Austin Neighborhood

Marie Oehlerking
CRP 386  | Introduction to GIS  | Fall 2013
School of Architecture  | The University of Texas at Austin

December 11, 2013
EXECUTIVE SUMMARY

East Austin’s Chestnut Neighborhood has witnessed the effects of gentrification in its surrounding neighborhoods. Almost overnight, single family dwellings that have stood in the neighborhood for decades have been replaced with mid-rise apartment blocks and new commercial construction and with this physical loss comes a culture casualty as well. Chestnut has recognized this fact and is determined to prevent the destruction of their historic sites and neighborhood character.

My GIS-based assessment will evaluate the risk factors associated with new development in order to understand how the historic character of the neighborhood will be affected. Historically, Chestnut has been a single-family residential neighborhood characterized by large lots and one-story houses. Structures are typically in the Bungalow/Craftsman style or a vernacular variation with signature hipped roofs and wood-sided facades.

Two architectural surveys have been previously conducted in the neighborhood by professional consultants and volunteers to identify sites that contribute to the overall historic character. Sites were ranked by significance and integrity. The proximity of increased population density, change in land use, and the number of building/demolition permits can result in loss of the neighborhood’s historic character. These proxies will be used to determine which historic sites are at risk.

There are three potential historic districts located in Chestnut, which were evaluated based on the aforementioned criteria. The analysis yields that all three districts are at risk of being lost, however, some districts are significantly more at risk. The Chestnut Neighborhood Plan Contact Team should consider pursuing a local historic designation to prevent their destruction.
INTRODUCTION

East Austin in one of the hottest real estate markets in the country. Over the past decade, rapid growth and development have started to change the overall character of the area. The Chestnut Neighborhood is located in East Austin between Martin Luther King Jr. Boulevard (north), 12th Street (south), Chicon Street (west), and a major railroad that cuts across the far east side. Chestnut was one of the first neighborhoods in Austin to develop and adopt a Neighborhood Plan, which was completed in 1999. During this time, growth had stagnated and people were moving out of the area. The plan was positioned to help encourage development by incorporating commercial zoning and multi-family housing into the single family neighborhood. Today, this plan has helped the community grow, however, current residents are worried that if development continues at such a rapid rate, the few historic sites that still exist will be lost along with their residential neighborhood character.

The Chestnut Neighborhood Plan Contact Team has enlisted Dr. Michael Holleran’s Preservation Planning and Practice class to help them figure out how proceed in to securing the future of their historic neighborhood. Their goal is to gain knowledge that supports their argument and to create a physical document that can be used to persuade developers and city officials that if they want to change the neighborhood to do it with respect to its historic sites and character. This GIS study will support the class’ efforts by creating maps that analyze factors associated with new development that place Chestnut’s historic character at risk.

Left: typical Chestnut house. Right: Neighborhood context.
Literature Review

The relationship between historic preservation and gentrification has evolved over the past several decades. Once believed to be a cause of displacement, preservation is now seen as a remediation strategy. The following studies explain.

Sharon Zukin, in her 1987 study, uses historic preservation as one of the indicators of gentrification. She states that the gentrification movement began in the 1960s and was typically associated with a shift in corporation investment, expansion of the urban service economy, and more immediately with the restoration of deteriorated houses. She claims that the gentrifiers, typically white middle-class people, are attracted to certain areas due to the affordability and availability of an older building stock. Through preservation, the new middle class can achieve higher social status through a relatively small investment of time and money. She concludes that historic preservation facilitates the original population through rising property values, rents and a higher sale price.

In a more recent study, the Metropolitan Planning Commission (MPC) of Savannah, Georgia encourages preservation as gentrification prevention. The MPC Gentrification Task Force in early 2004 after a series of roundtable discussions that highlighted the issue. Their mission was to “to examine gentrification (as defined in this report) in neighborhoods and to recommend policies and practices to mitigate the negative effects of gentrification while stimulating both residential and commercial revitalization.”

The MPC realized that gentrification could result in the loss of neighborhood identity, which is one of the city’s greatest assets. Therefore, they needed to mitigate the effects while encouraging revitalization. Over a three-month period, the MPC identified at-risk neighborhoods through prediction factors that suggested where gentrification was likely

---

to happen. These included, high rate of renters, ease of access downtown, decline in population, low housing cost, and historic architecture. They also looked at primary indicators where gentrification was already happening including, increase in household income, increase in property value, and lack of affordable housing. The report concluded by offering remedial efforts that could be applied through planning, land use and zoning, education, and redevelopment programs. Redevelopment is considered a form of preservation where neighborhood identity is promoted and underutilized buildings are rehabilitated as affordable housing.

The Brookings Institute study defines gentrification as “as the process by which higher income households displace lower income residents of a neighborhood, changing the essential character and flavor of that neighborhood.”. They identify indicators of areas susceptible to gentrification including: high rate of renters, ease of access to job centers (freeways, public transit, etc.), high and increasing levels of metropolitan congestion, high architectural value, comparatively low housing values. Four case studies were conducted in major cities across the country to better understand the effects of gentrification. The study concluded that involuntary displacement of residents is the most significant adverse effect. They also concluded that the pace of change is directly linked to the number of problems for the neighborhood. The Brookings Institute encourages communities to seek and “equitable development” strategy that creates and maintains economically and socially diverse neighborhoods that are stable over a long period of time. This minimizes the displacement and ill effects on the lower income residents.

The Florida Atlantic University and Florida International University have developed a handbook for neighborhood for strategies that encourage development without displacing the current population. The handbook starts off by defining gentrification much as the Savannah MPC and Brookings Institute studies have and then outlines steps that can be taken to preserve neighborhood character while encouraging growth. First, the neighborhood should organize themselves and define boundaries. They should also outline the priorities for the area. The new organization then needs to gather information about their neighborhood including zoning maps, aerial maps, and an architectural survey. The handbook encourages the neighborhood to “preserve what is already there” through code enforcement and law enforcement. This will make the neighborhood more aesthetically appealing and safer for everyone. Then, the handbook suggests to create a enforceable neighborhood plan that explains the goals of the area and creates tailored toolbox of zoning types and regulations for the type of development the area needs.

Early 1920s planning efforts segregated East Austin from the rest of the city by initially relocating African–American schools to the area. The area eventually grew into a thriving, close knit enclave with its own commercial core at East 11th and 12th street,

---

2 The Brookings Institution, *Dealing with Neighborhood Change*.
3 Florida Atlantic University, *Development Without Displacement Community Handbook*
however, the synergy was lost after integration in the 1960s. The current status of East Austin is the perfect storm of gentrification indicators. As Michael Emergy explains, “the geographical nearness to downtown, the simple economics of still-affordable property and a retreating social stigma about East Austin have led to urban gentrification. Economics are starting to reduce to ability of indigenous families to maintain their stand in Central East Austin. White families and businesses are becoming downright popular.”

In terms of gentrification, preservation can be double edge sword. Low property values can attract outside buyers who will remodel the house and en masse will displace entire communities. However, preservation can be used as a tool to prevent gentrification and encourage positive development. This study will analysis factors associated with gentrification and new development in order to determine which of Chestnut’s historic sites are at risk.

**Neighborhood Background**
Historically, Chestnut has been a single-family residential neighborhood with a high population of African-Americans. It was a hub for the Civil Rights Movement in Austin and is located near the Rosewood neighborhood, who has several buildings designed by John S. Chase, who was the first African-American to graduate from the University of Texas’ School of Architecture.

---

4 Emery, “East Austin Gentrification.”
Two efforts have been made to document the cultural resources of Chestnut. In 2001, a historic resource survey was conducted by Hardy-Heck Moore & Myers, Inc., in which they identified and classified historic sites in Chestnut based on significance and integrity. Sites are ranked by high, medium, or low priority. 28 high priority sites were identified and are considered to have the most potential for historic designation. High priority sites are considered to be: “excellent examples of architecture, engineering, or crafted design. They retain their original contextual and architectural integrity to a good degree and, if altered, changes are in keeping with original design, scale, and workmanship. These properties contribute significantly to local history or broader historical patterns and are considered to be the most significant resources within the project area.”

The 2001 survey also identified 37 “Hofheinz” houses, which are excellent representatives of early 20th century development of East Austin. The structures were built between 1910 and 1935 and were used as rental houses that were originally owned by a local businessman, Oscar Hofheinz. This information was uploaded to the Austin Historical Survey Wiki, which is open to the public. The rapid pace of change in the

---

5 Hardy, Heck, Moore, & Myers Survey 2001
neighborhood has made this survey “historic” in its own right. The Chestnut Neighborhood Plan Contact Team (CNCPT) recently completed a separate architectural survey. This survey documents all building elements and materials used for construction. For this study, I will use the 2001 survey as a foundation for proposed historic districts.

Examples of Hofheinz Houses in Chestnut

Chestnut’s historic character can be lost through several means:

- Complete demolition of residences
- Subdivision of lots resulting in a higher density of buildings
- Change in use from strictly residential to commercial
- New construction that is significantly taller than residential buildings (over three stories)

I will use population density, change in land use, and the number of building/demolition permits as proxies for in relationship to the historic sites of the neighborhood in order to understand which sites are more at risk. By analyzing these risk factors in Chestnut and the surrounding neighborhoods, I can help the Chestnut Neighborhood Plan Contact Team better understand what types of development hurt their neighborhood and can pinpoint specific locations were development would have less of an impact.

RESEARCH QUESTIONS

Overall Concept - What are the threats to the historic neighborhood of Chestnut? How can preservation efforts retain the historic character while encouraging development that will help the entire community?

- Where are the historic sites identified in the 2001 architectural survey located? Do they still exist? What is their condition?
- What other buildings and sites exist that contribute to Chestnut’s historic character and what are their condition?
- What historic sites are more at risk based on surrounding development trends and factors associated with the particular sites?
HYPOTHESIS

Based on prior research and visual survey of the area, historic sites along major roadways including Martin Luther King Jr. Boulevard and East 12th Street will be more at risk. East 12th Street between IH-35 and Poquito Street and East 11th Street are zoned as redevelopment areas under a Neighborhood Conservation Combining District overlay implemented in support of an urban renewal plan for the area. Since 2008, the area has seen rapid growth and destruction of the residential neighborhood for new high density mixed use.

METHODOLOGY

To better understand the Chestnut neighborhood, the existing documentation was analyzed in depth. The 1999 Neighborhood Plan was analyzed to understand how it has shaped the neighborhood. The 2001 Hardy, Heck, Moore,& Myers survey was used to identify and rank historic sites based on significance. Then a walking survey was conducted to better understand the historic character and current state of the neighborhood. The CNCPT held several meetings between August 2013 and November 2013. Meetings were attended in order to understand their needs and intentions. The CNCPT is currently developing a document concerning Chestnut density issues. They are also creating a brochure for developments to simplify the communication of their expectations for new development.

Reference Maps

Using the data obtained form the City of Austin website, two reference maps were made to understand the physical location of the Chestnut neighborhood. Reference 1 (R.1) depicts the Chestnut neighborhood boundary and its surrounding neighborhoods. Each boundary is associated with an existing neighborhood plan created by the City. The two major road, IH-35 and Airport Boulevard, were incorporated for orientation.

Data Sources

- City of Austin
  - 2003 Building Profiles
  - Lots and Rows
  - Neighborhood Planning Boundaries
  - Local Landmarks
  - Roads

Reference 2 (R.2) illustrates the identified historic sites. The 2003 building profiles and address points were combined to create a site plan with accurate addresses. Ranked Historic sites ranked by priority were manually added to the shapefile along with the location Hofheinz Houses. The location of Moonlight Towers was taken from the local land landmark shapefile. They are the only structures in the neighborhood with a Local Historic Landmark Designation.
Data Sources

- City of Austin
  - 2003 Building Profiles
  - Address Points
  - Lots and Rows
  - Chestnut Boundary
  - Local Landmarks
  - Hardy, Heck, Moore, & Myers 2001 Survey

All data is projected at NAD 1983 State Plane Texas Central FIPS 4203 Feet.

1.0 Population Density maps

Using census block group boundaries and demographic data from Social Explorer, two maps were created showing the population density in 2000 and 2010, which depicts the number of people per square mile. Population density was classified into five groups using natural breaks and symbolized using a teal gradient.

Data Sources

- CAPCOG
  - Austin City Limits
- Social Explorer
  - 2000 Census Demographic Data
  - 2010 Census Demographic Data
- Tigerline
  - 2000 Block Groups
  - 2010 Block Groups

All data is projected at NAD 1983 State Plane Texas Central FIPS 4203 Feet.

2.0 Land Use Maps

Three land use maps were created for every decade starting in 1990. Land use is symbolized using the standard colors approved by the City of Austin. Each maps shows the neighborhoods surrounding Chestnut. These areas have already seen rapid growth and were included to understand how land use changed to accommodate the new construction.

The fourth land use map compares 2010 land use with future land use. New types of land use including mixed use and specific regulating district appear in the future land use map. Land use types were symbolized using the standards colors approved by the City of Austin.

Data Sources

- City of Austin
  - 2003 Building Profiles
  - Lots and Rows
Neighborhood Planning Boundaries
1990 Land Use
2000 Land Use
2010 Land Use
Future Land Use

All data is projected at NAD 1983 State Plane Texas Central FIPS 4203 Feet.

3.0 Building / Demolition Permits

Building permit shapefiles were gathered from the City of Austin Growth Watch website for every year since the Chestnut Neighborhood Plan in 2001. Each shapefile contains a description field for the type of permit that was approved. The shapefiles were merged into two files, 2001–2006 in one and 2007-2013 in the other. This was done for visual simplicity. The shapefiles were then symbolized by demolition, remodel/repair, and other. Other contains several categories, but most are new construction or an addition to an existing house. The building permit shapefile were then overlaid on to the lots and building footprints of Chestnut. High priority sites were highlighted in pink.

Data Sources
• City of Austin
  o 2003 Building Profiles
  o Lots and Rows
  o Neighborhood Planning Boundaries
• City of Austin Growth Watch
  o 2001 – 2013 Building Permits

All data is projected at NAD 1983 State Plane Texas Central FIPS 4203 Feet.

4.0 Risk Assessment

Future land use and the building permit shapefiles were overlaid in a new map document. Three areas were chosen for proposed historic district or multiple properties sites based on the close proximity of several high priority structures. A 500 foot buffer was then placed around each proposed district to analyze near by factors. 500 feet was chosen because it allows a block in all directions to be encompassed by the boundary. The number of mixed use, specific regulating district, and various types of building permits were noted. These numbers were then compared and the sites were ranked by highest risk to lowest risk.

Data Sources
• City of Austin
  o 2003 Building Profiles
  o Lots and Rows
  o Neighborhood Planning Boundaries
• City of Austin Growth Watch
  o 2001 – 2013 Building Permits
FINDINGS

The findings from this study are included in the following series of maps.
R.2 - Identified Historic Sites

Ranked by Priority

- Hofheinz House
- Moonlight Towers
- High
- Chestnut Boundary
- Medium
- Low
- Lots

Author: Marie Oehlerking  Date: December 11, 2013
Source: City of Austin, Hardy Heck Moore Chestnut Survey
Projected Coordinate System: NAD 1983 State Plane Texas Central FIPS 4203 (FT)
1.0 - Population Density

2000 Population Density by block groups

- Chestnut Boundary
- 0 - 2500 people
- 2501 - 5000 people
- 5001 - 13000 people
- 13001 - 25000 people
- 25001 - 47000 people

2010 Population Density by block groups

- Miles

Author: Marie Oehlerking  
Date: December 11, 2013  
Source: CAPCOG, City of Austin, Social Explorer, TigerLine  
Projected Coordinate System: NAD 1983 State Plane Texas Central FIPS 4203 (F)
2.1 - 1990 Land Use

- Structures
- Chestnut Boundary

- Single Family Residential
- Multi Family Residential
- Commercial
- Office
- Industrial
- Civic
- Recreation / Open Space
- Transportation
- Undeveloped

Miles

Author: Marie Oehlerking  Date: December 11, 2013
Source: City of Austin
Projected Coordinate System: NAD 1983 State Plane Texas Central FIPS 4203 (F1)
2.2 - 2000 Land Use

- Structures
- Chestnut Boundary
- Single Family Residential
- Multi Family Residential
- Commercial
- Office
- Industrial
- Civic
- Recreation / Open Space
- Transportation
- Undeveloped

Miles

0 0.25 0.5 1

Author: Marie Oehlerking  Date: December 11, 2013
Source: City of Austin
Projected Coordinate System: NAD 1983 State Plane Texas Central FIPS 4203 (F1)
2.3 - 2010 Land Use

Structures | Chestnut Boundary
---|---

- **Yellow**: Single Family Residential
- **Brown**: Multi Family Residential
- **Red**: Commercial
- **Pink**: Office
- **Purple**: Industrial
- **Blue**: Civic
- **Green**: Recreation / Open Space
- **Gray**: Transportation
- **White**: Undeveloped

Miles

Author: Marie Oehlerking  I  Date: December 11, 2013  
Source: City of Austin  
Projected Coordinate System: NAD 1983 State Plane Texas Central FIPS 4203 (F1)
2.4 - Current vs. Future Land Use

2010 Land Use

Future Land Use

Chestnut Boundary
High
Other Sites
Single Family
Multi Family
Commercial
Office
Industrial
Civic
Recreation
Mixed Use
Specific Regulating District

Author: Marie Oehlerking  Date: December 11, 2013
Source: City of Austin
Projected Coordinate System: NAD 1983 State Plane Texas Central FIPS 4203 (Ft)
3.1 - Construction Permits
between 2001 and 2006

- Building Permits
- Demolition Permits
- Residential Remodel
- Other Sites
- High Priority Sites
- Chestnut Boundary

Miles

Author: Marie Oehlerking  Date: December 11, 2013
Source: City of Austin, Hardy Heck Moore Chestnut Survey
Projected Coordinate System: NAD 1983 State Plane Texas Central FIPS 4203 (F1)
Saving Chestnut
A Risk Assessment for an East Austin Neighborhood

3.2 - Construction Permits
between 2007 and 2013

- Building Permits
- Demolition Permits
- Residential Remodel
- Other Sites
- High Priority Sites
- Chestnut Boundary

Miles
0 0.25 0.5

Author: Marie Oehlerking  Date: December 11, 2013
Source: City of Austin, Hardy Heck Moore Chestnut Survey
Projected Coordinate System: NAD 1983 State Plane Texas Central FIPS 4203 (Ft)
4.1 - Proposed District A

- Building Permits
- Demolition Permits
- Remodel/Repair

Other Sites
High Priority Sites
500 ft buffer
Chestnut Boundary

Permit Totals
Building - 109
Demolition - 18
Remodel/Repair - 67
4.2 - Proposed District B

- ▲ Building Permits
- ▼ Demolition Permits
- ● Residential Remodel
- □ Other Sites
- ▼ High Priority Sites
- ● 500 ft buffer
- □ Chestnut Boundary

Permit Totals

- Building - 80
- Demolition - 23
- Remodel/Repair - 50

Author: Marie Oehlerking  Date: December 11, 2013
Source: City of Austin, Hardy Heck Moore Chestnut Survey
Projected Coordinate System: NAD 1983 State Plane Texas Central FIPS 4203 (FT)
4.3 - Proposed District C

- Building Permits
- Demolition Permits
- Remodel/Repair

<table>
<thead>
<tr>
<th>Permit Totals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building - 137</td>
</tr>
<tr>
<td>Demolition - 20</td>
</tr>
<tr>
<td>Remodel/Repair - 91</td>
</tr>
</tbody>
</table>

Author: Marie Oehlerking  
Date: December 11, 2013
Source: City of Austin, Hardy Heck Moore Chestnut Survey
Projected Coordinate System: NAD 1983 State Plane Texas Central FIPS 4203 (F1)
4.4 - Risk Assessment

- **High Risk**
- **Medium Risk**
- **Low Risk**
- **Chestnut Boundary**
- **Moonlight Towers**
- **High Priority**
- **Other Structures**

Author: Marie Oehlerking  I  Date: December 11, 2013
Source: City of Austin, Hardy Heck Moore Chestnut Survey
Projected Coordinate System: NAD 1983 State Plane Texas Central FIPS 4203 (FT)
ANALYSIS

2.0 Land Use maps
The 1990, 2000, 2010 land use maps were first compared to understand major changes in the area. Between 1990 and 2000 it appears that commercial areas (red) to the north and also to directly to the west of Chestnut were changed to an office, industrial, or undeveloped site. Very few changes appear within the Chestnut boundary, however, one civic site is lost.

Between 2000 and 2010 very few changes appear outside of the Chestnut boundary. It is worth noting that the large development to the northeast of Chestnut, which used to contain the airport, has been redeveloped into single family residential. Within Chestnut, many undeveloped sites are converted to single family residential or recreation space.

The 2010 and Future Land Use maps show major changes both inside and outside of Chestnut. Many sites along the neighborhood boundary will be rezoned as mixed use or specific regulating districts, which allow for taller buildings and increases the number of housing units. Mixed use developments also increase commercial units along the first story of the structure. Also more recreation space and multi-family housing can be found towards the interior of the neighborhood. The changes in zoning suggest that the City of Austin is encouraging a more dense, walkable neighborhood, which is good for the community. However, changes in zoning could potentially be bad if the changes start appearing within the heart of the neighborhood.

3.0 Building / Demolition Permits
Two high priority sites have been lost to demolition along the west side of Chestnut. It also appears that many demolitions have occurred in areas where land use has changed. Numerous remodel/repairs have taken place in the area, which could be good for the historic sites of Chestnut. However, if these changes were not conscious of the historic fabric of high priority buildings and altered too much, the integrity of these sites could be lost. Building permits incorporates all new construction, additions, and miscellaneous permits. Further investigation should be done to understand the consequences of these permits.

4.0 Risk Assessment
Of the high priority historic sites, zero qualify to be designated as a local or National Register landmark due to the condition and/or alterations made to the structure. However, multiple historic sites are located within close proximity of each other in three different parts of Chestnut. Therefore, each of these areas could potentially be designated as a historic district or multiple property site.
After each potential district was buffered, the following was found:

<table>
<thead>
<tr>
<th>Proposed District</th>
<th># of historic sites</th>
<th>Mixed Use</th>
<th>Special Reg District</th>
<th>Demo Permit</th>
<th>Building Permit</th>
<th>Remodel Permit</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>9</td>
<td>2.5 lots</td>
<td>None</td>
<td>18</td>
<td>109</td>
<td>67</td>
<td>2 demolished historic sites</td>
</tr>
<tr>
<td>B</td>
<td>10</td>
<td>14 lots</td>
<td>2 lots</td>
<td>23</td>
<td>80</td>
<td>50</td>
<td>1 Civic historic site</td>
</tr>
<tr>
<td>C</td>
<td>4</td>
<td>4 lots</td>
<td>2 lots</td>
<td>20</td>
<td>137</td>
<td>81</td>
<td>_</td>
</tr>
</tbody>
</table>

First, the number of buildings in a proposed historic district was taken into consideration. More properties yield more significance when nominating a property, which in turn yields more success in getting that property designated and saving it from demolition.

Then, the change in land use was evaluated. Structures near a significant change in land use are more susceptible to be demolition themselves. Also structures near major roads appear to be more susceptible to change in land use.

Demolition permits were also weighted heavily when considering the data. Only district had demolished high priority sites, however, if numerous demolitions have taken place in one area, then a historic site could be more at risk.

Given the above criteria, Proposed District B has the highest risk. The outlying historic districts also are at a high risk, because they are less likely to be saved unless an individual takes a special interest in them. Proposed District C was ranked at a medium risk, while Proposed District A was ranked at the lowest risk.
CONCLUSIONS and RECOMMENDATIONS

Change is coming to Chestnut. As the data shows, the perimeter of the neighborhood will be experiencing rapid growth in the not so near future, if it has not started already. The Chestnut Neighborhood Plan Contact Team needs to take action to preserve their historic sites before these sites and neighborhood culture are lost forever. The CNPCT should consider pursuing one of the local designations as described in Appendix III. The Local Historic Landmark District or Neighborhood Conservation Combing District have the ability to prevent the demolition of historic sites, while the later in particular can encourage “equitable development.”

Further research should also be considered. The sites that are associated with demolition permits should be surveyed specifically to see what was put in the original structure’s place. The recent architecture survey conducted by the CNPCT should also be amended to include which sites definitely have a newly construction building to better understand the implications of the building permits. Zoning, property values, and household income could also be evaluated to better understand the effects of gentrification in Chestnut.
REFERENCES

Austin Revitalization Authority. “Mission Statement.” Available at: http://austinrev.org/


Appendices
**APPENDIX I: Detailed Outline of Actions Taken to Complete Analysis**

**Unprojected Shapefile Preparation:**
1. Open ArcCatalog
2. Navigate to Final Project > Data folder > Select Shapefile
3. Search > Define Projection (Data Management) > Click on tool to open
   a. Input Dataset or Feature class > Open folder > Navigate to Shapefile
4. Search > Project (Data Management ) > Click on tool to open
   a. Input Dataset or Feature class > Open folder > Navigate to Shapefile
   b. Output Dataset or Feature class > Rename Shapefile
5. List > Output Coordinate System > Select > Projected Coordinate System NAD 1983 State Plane Texas Central FIPS 4203 Feet > OK

**Create Base File**
1. Open a new ArcMap document.
2. Connect to Final Project > Data folder
   a. Add Data > counties.shp, city_limits.shp, neighborhood_plans.shp, streets.shp, major_highways.shp, 2003_bldg_footprints.shp, address_points.shp, lots_rows.shp
3. Selected Travis County manually
   a. Right click counties.shp > Data > Export Data
   b. Save shapefile as travis_co.shp
4. Removed counties.shp
5. Clip city_limits.shp to travis_co.shp
   a. Save shapefile as austin_boundary.shp
6. Removed city_limits.shp
7. Select Chestnut boundary manually from neighborhood_plans.shp
   a. Right click neighborhood_plans.shp > Data > Export Data
   b. Save shapefile as Chestnut_Boundary.shp
8. Select surrounding neighborhood boundaries manually from neighborhood_plans.shp.
   a. Right click neighborhood_plans.shp > Data > Export Data
   b. Save shapefile as surrounding_neigh.shp
9. Clip streets.shp to Chestnut_Boundary.shp
   a. Save shapefile as CHESTNUT_streets.shp
10. Clip 2003_bldg_footprints.shp to Chestnut_Boundary.shp
   a. Save shapefile as CHESTNUT_bldg_footprint.shp
11. Clip address_points.shp to Chestnut_Boundary.shp
    a. Save shapefile as CHESTNUT_addresses.shp
12. Right click CHESTNUT_addresses.shp > Joins and Relates > Joins
    a. What do you want to join to this layer? : Spatial Join
b. Join to CHESTNUT_bldg_footprint.shp  
c. Save shapefile as C_bldg_footprints_join.shp  

13. Clip lots_rows.shp to Chestnut_Boundary.shp  
a. Save shapefile as CHESTNUT_lots.shp

**Neighborhood Planning Areas map**  
1. Open base map document file.  
2. Right click neighborhood_plans.shp > Properties > Symbology > Unique Values  
   a. Field > Name  
   b. Add Values > Chestnut, Upper Boggy Creek, Central East Austin, Rosewood  
   c. Symbolize using four different colors.  
3. Label neighborhoods  
   a. Draw > Label > Place at point clicked

**1960 Demographics and 2010 Demographics map**  
1. Open base map document file.  
2. Connect to Final Project > Data folder  
   a. Add Data > 1960_census_tract.shp  
3. Right click 1960_census_tract.shp > Joins and Relates > Joins  
   a. What do you want to join to this layer? : Join attributes from a table  
   b. Field that the join will be based on : GEOID_Num  
   c. Table to join to the layer > nhgis_1960_tract.xls  
   d. Field in the table to base the join on : GISJOIN  
   e. Keep only matching records > OK  
4. Right click 1960_census_tract.shp > Properties > Symbology > Quantities  
   a. Value > TotalNonWhitePop  
   b. Normalize > TotalPop  
   c. Divide into five classes and classify by Natural Breaks  
   d. Symbolize using orange gradient range  
5. Repeat all steps for 2010 Demographics using 2010_census_tracts.shp

**Identified Historic Sites map**  
1. Open base map document file.  
2. Right click C_bldg_footprints_join.shp  
   a. Open attribute table  
   b. Add field and name designation  
   d. Add field and name Hofheinz  
   e. Manually add Hofheinz House from Chestnut Neighborhood Historic Resource Survey 2001  
3. Right click C_bldg_footprints_join.shp > Data > Export Data
34

1. Download necessary Census data from Social Explorer.
   a. Decennial Census Block Groups: 2000, 2010
      i. Total Population
      ii. Population Density
      iii. Race
2. Download CSV and save as 2000_census_bg_demo and 2010_census_bg_demo respectively.
3. Open CSV in Microsoft Excel. Save files as Excel 97-03 Workbook.
4. Rename headings something meaningful and recognizable to expedite the mapping process.
5. Open base map document file.
7. Right click 2000_blockgroup.shp > Joins and Relates > Joins
   a. What do you want to join to this layer? : Join attributes from a table
   b. Field that the join will be based on : GEOID
   c. Table to join to the layer > 2000_census_bg_demo.xls
   d. Field in the table to base the join on : GEO_FIPS
   e. Keep only matching records > OK
8. Right click 1960_census_tract.shp > Properties > Symbology > Quantities
   a. Value > PopDensity
   b. Divide into five classes and classify by Natural Breaks
   c. Symbolize using blue gradient range

1990, 2000, 2010 and Future Land Use
1. Open base map document file.
2. Import landuse_1990.shp.
4. Symbolize landuse_1990.shp using the standard colors from the City of Austin.
5. Highlight the Chestnut boundary with black dashed line
6. Import C_bldg_footprints_join.shp.
7. Symbolize C_bldg_footprints_join.shp using medium gray coloration for all designations.

Construction Permits (2001-2006) and (2007-2013)
1. Open base map document file.
2. Import all building permits shapefiles for 2001-2006.
3. Clip all bp files to surrounding_neigh.shp.
4. Merge all bp files
   a. Input > all single year files
   b. Output > bp_01_06.shp
5. Right click bp_01_06.shp > Properties > Symbology > Unique Values
   a. Check “all other values” box > symbolize using blue triangle
   b. Add Value > Demolition > symbolize using dark pink x
   c. Add Value > Remodel/Repair > symbolize using green circle

Proposed Historic District(s) with factors
1. c bp_01_13.shp, futurelanduse.shp, and hp_designations.shp.
   a. Symbolize hp_designations.shp showing high priority only.
   b. Symbolize other shapefiles to correspond with maps above.
2. Hide all layers except chestnut_lots.shp and hp_designations.shp
3. Manually select all lots in proposed historic district area.
4. Right click chestnut_lots.shp > Data > Export Data
   a. Save as hist_district_A.shp
5. Geoprocessing > Dissolve
   a. Input > hist_district_A.shp
   b. Save as hist_district_A_dissolve.shp
6. Geoprocessing > Buffer
   a. Input > hist_district_A_dissolve.shp
   b. Linear Feet > 500
   c. Save as hist_district_A_dis_buff.shp
7. Selection > Selection by location
   a. Selection features in Import bp_01_13.shp
   b. Source layer: hist_district_A_dis_buff.shp
   c. Select “completely within source layer”
8. Right click bp_01_13.shp > Data > Export Data
   a. Save as bp_hist_dist_A.shp
9. Repeat for other proposed historic district areas.

Historic Sites Ranked by Risk
1. Open base map document file.
2. Import hist_district_A_dissolve.shp, hist_district_b_dissolve.shp, and hist_district_A_dissolve.shp
3. Symbolize each layer based on determined rank
   a. High Risk – Dark Blue
   b. Medium Risk – Medium Blue
   c. Low Risk – Light Blue
**APPENDIX II: Data Sources**

**Austin Historical Survey Wiki**

**Capital Area Council of Governments**

**City of Austin**

**City of Austin Growth Watch**

**National Historical Geographic Information System**
• 1960 Census Tracts [zip]. St. Paul, Minnesota: University of Minnesota. Available at: https://www.nhgis.org/

Social Explorer

U.S. Census Bureau TigerLine
## Appendix III: Available Austin Preservation Designations

<table>
<thead>
<tr>
<th>Description</th>
<th>Individual Local Landmark (H)</th>
<th>Local Historic “Landmark” District (HD)</th>
<th>Neighborhood Conservation Combining District (NCCD)</th>
<th>National Register District (NR)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Designation</strong></td>
<td>Individual structures or sites that are of:</td>
<td>Geographically defined areas possessing a significant concentration of buildings united by their history and/or architecture.</td>
<td>Geographically defined area possessing architectural, historical, or cultural significance</td>
<td>Geographic area possessing sites, buildings, structures, and objects that share historical, cultural, and/or architectural significance</td>
</tr>
<tr>
<td><strong>Eligibility</strong></td>
<td>Architectural</td>
<td>Geographically defined area</td>
<td>Defines boundaries separating residential from commercial areas based on neighborhood plan</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Historical</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Archaeological</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cultural significance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Implications</strong></td>
<td>• 50 years old (except in cases of exceptional significance)</td>
<td>• At least one block face</td>
<td>• 30 years old</td>
<td>• Historic significance of district as a whole</td>
</tr>
<tr>
<td></td>
<td>• High degree of integrity</td>
<td>• 51% of main structures contribute to historic character (contributing properties are those 50+ years old, built during period of historical significance and retain historic appearance)</td>
<td>• “Distinctive architectural styles”</td>
<td>• Boundary determined by a concentration of contributing properties (contributing properties are those 50+ years old, built during period of historical significance and retain historic appearance)</td>
</tr>
<tr>
<td></td>
<td>• Designated at the State or Federal level OR significant in 2 categories (Architecture, Associations, Archaeology, Community Value, Landscape)</td>
<td>• Can be initiated by 51% of property owners or owners of 51% of land</td>
<td>• Minimum 5 contiguous acres (including streets &amp; alleys); 3 separate parcels</td>
<td>• Owners’ approval not required</td>
</tr>
<tr>
<td></td>
<td>• Can be vetoed by 51% of property owners</td>
<td></td>
<td>• Can be vetoed by 51% of property owners</td>
<td>• Can be vetoed by disapproval of &gt;50% of contributing-property owners</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Designation</strong></td>
<td>Local - Austin City Council</td>
<td>Local - Austin City Council</td>
<td>Local - Austin City Council</td>
<td>Federal - National Park Service</td>
</tr>
<tr>
<td><strong>Implications</strong></td>
<td>• Historic Landmark Commission review of exterior and site changes, demolition and relocation based on Sec. of Interior’s Standards</td>
<td>• Historic Landmark Commission review of exterior and site changes, demolition and relocation</td>
<td>• Brings historic character of neighborhood to the forefront of decision making</td>
<td>• Prestigious recognition of a concentration of significant properties</td>
</tr>
<tr>
<td></td>
<td>• Partial property tax exemptions available from City, AISD and Travis County</td>
<td>• Use design standards based on Sec. of Interior Standards created for the neighborhood and adopted by the City Council</td>
<td>• Great flexibility to determine strategy</td>
<td>• Rehabilitation of income producing contributing properties may be eligible for Federal Rehabilitation Tax Credits and State Franchise Tax Credits</td>
</tr>
<tr>
<td></td>
<td>• Amount of exemption depends on residential vs. commercial use and when property was designated or changed ownership.</td>
<td>• Design standards may provide further restrictions than existing codes and regs.</td>
<td>• Neighborhood has significant control over development and alterations in their district</td>
<td>• A state sales tax exemption on labor is available for work to income producing buildings listed in the National Register of Historic Places.</td>
</tr>
<tr>
<td></td>
<td>• Rehabilitation of income producing Landmarked properties may be eligible for Federal Rehabilitation Tax Credits and State Franchise Tax Credits</td>
<td>• City property tax abatement available to promote rehabilitation of contributing buildings (&amp; non-contributing buildings if the project will restore them to contributing status.)</td>
<td>• Restrictions guided by a conditional overlay based on community goals</td>
<td>• Allows City to delay releasing demo permits for up to 180 days for contributing structures</td>
</tr>
<tr>
<td></td>
<td>• Maintains cultural heritage</td>
<td>• Rehabilitation of income producing contributing properties may be eligible for Federal Rehabilitation Tax Credits and State Franchise Tax Credits encourages better design</td>
<td>• Sets standards for new development, redevelopment, or significant remodeling to maintain the neighborhood’s character</td>
<td>• Promotes the maintenance of contributing structures</td>
</tr>
<tr>
<td></td>
<td>• Positive economic impact from (heritage) tourism and job creation</td>
<td>• Maintains cultural heritage</td>
<td>• Can prohibit / limit uses or allow uses in a base zoning district where they were not previously allowed</td>
<td>• Positive economic impact from (heritage) tourism and job creation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Positive economic impact from (heritage) tourism and job creation</td>
<td></td>
<td>• Assists government and private groups who are planning new development</td>
</tr>
<tr>
<td>Restrictions</td>
<td>Application Process</td>
<td>Examples</td>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------</td>
<td>----------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td><strong>Restrictions</strong></td>
<td><strong>Application Process</strong></td>
<td><strong>Examples</strong></td>
<td><strong>Notes</strong></td>
<td></td>
</tr>
<tr>
<td>Certificate of Appropriateness (CoA) approval by Historic Landmark Commission required for:  • Exterior and site alterations  • Additions  • Demolition or Relocation  • Historic Preservation Officer may administratively approve:  o “normal repair &amp; maintenance,”  o Small additions or outbuildings (one-story, &lt; 600 sq ft)  o 2-story additions not visible from street  o Decks, fences, etc</td>
<td>Applicants submit application with historical documentation demonstrating eligibility  • The case goes to City Historic Landmark Commission and Planning Commission for recommendation prior to Austin City Council  • Property owners, utility account holders and neighborhood associations within 500 feet notified of public hearings 11 days prior to the hearing date  • Final approval is by the City Council  • Time Estimate – 3-4 months</td>
<td>Austin has 582 individual landmarks including:  • The State Capitol  • The Central Library (History Center)  • Residences  • Commercial buildings Full List here: <a href="http://austintexas.gov/sites/default/files/files/Planning/Historic_Preservation/Austin_Landmarks_by_Address.pdf">http://austintexas.gov/sites/default/files/files/Planning/Historic_Preservation/Austin_Landmarks_by_Address.pdf</a></td>
<td>*East 11th and 12th Street:  • The southwest corner of Chestnut is already affected by an NCCD created by Ordinance 20080228-087.  • Applies to 12th Street from IH-35 to Poquito Street  • Implemented in support of the East 11th and 12th Street Urban Renewal Plan (URP).  • Modifies provisions of the City’s land development code to customize the standards to allow mixed use development</td>
<td>Austin has 3 Local Historic districts:  • Castle Hill  • Harthan Street  • Hyde Park</td>
</tr>
<tr>
<td>Certificate of Appropriateness (CoA) approval by Historic Landmark Commission required for permits for:  • Contributing structures and new construction only  • Alterations beyond “normal repair &amp; maintenance”  • Additions  • Demolition or Relocation  • Historic Preservation Officer may administratively approve minor projects as outlined in design standards.</td>
<td>Applicants submit application to Historic Preservation Office  • Case goes to City Historic Landmark Commission and Planning Commission for recommendation prior to City Council  • Property owners, utility account holders and neighborhood associations within 500 feet of proposed boundaries notified of public hearings 11 days prior to the hearing date  • Final approval is by the City Council  • Time Estimate – 3-4 months</td>
<td>Examples of NCCD include:  • Hyde Park  • North University  • Fairview Park  • “East 11th and 12th Street”</td>
<td>• Advisory review of changes, based on the Sec. of Interior’s Standards, is required by Historic Landmark Commission (HLC) may initiate historic zoning if changes would make property non-contributing.</td>
<td></td>
</tr>
</tbody>
</table>